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Manual Conventions

Italic text indicates a text on software UI.

Underlined text indicates a key stroke on keyboard.

Bold and italic text indicates graphics shown in this manual.

Symbols

5

A note provides important information, recommendations, reminders and
suggestions.

The See Also notes refer to other relevant sections, chapters or manuals.

A

The caution paragraph indicates a potentially dangerous operation.

Using the Mouse

Click

Press and release the left mouse button.

Right-click Press and release the right mouse button.

Double-click | Click the left mouse button twice in rapid succession.

Drag&drop Move the mouse while holding down the left mouse button and then

release.

Installation

B

Before the installation process, you must ensure that a file archiver software is
installed on the computer to extract installation files from compressed file.

If the computer has an antivirus software; before extracting installation files from
compressed file, you must ensure that antivirus doesn’t block all executable files by
setting it’s security level lower or deactivating it until installation process is over.

Before the installation process, you must ensure that the driver of graphics card is
properly installed.




Introduction

Easy OnAir runs with the NTSC, PAL, HD, SD files on the same playlist. It gains the
administration of users because of its user-friendly interface and 7/24 stable work.

Easy OnAir plays the video files with HD / SD, multi-format and multi resolution with the mix
of audio files in different sample rates. It automatically performs up-down conversion
operations for you according to the set output.

While Easy OnAir playlist is on air, it can be dynamically changed and playlist time is
automatically updated with change. New playlist can be created during on-air. A playlist can
be looped; a single video file can be repeated as well.

Playlist can be instantly paused, stopped, or changed during the broadcast. This process is done
at the end of the buffer or in real time on demand.

The playlists, activated on a desired day and time, can be arranged with the scheduled playlist
module. By the schedule module, the system can split the video files virtually without causing
any change. It is possible to monitor the broadcast output from the computer screen.

A preview of any video on the playlist can be played during the broadcast. The trimming
operations on video can also be done in real time without rendering.

The volume can be controlled through the program. There is time indicator on the program
showing the time of video clips and how much time is left to the end in the flow of the broadcast.

Playlist can be controlled by keyboard shortcuts. In addition, there is no restriction on number
of video files added to the playlist. You can easily add your files by drag and drop method or
by searching for the name of the file on the disk.

Easy OnAir automatically saves the broadcast traffic, the user actions and the history of system
on a daily basis.

Easy OnAir offers the advantage of character generator interface working integrated. It displays
logo, animations, crawls, rolls or different graphics on the playlist output with the character
generator interface.

In addition to overlaying time, counter, up-down, bottom-up, sliding from left to right, right to
left, and running scripts, image files in the playlist by planning, you can also instantly overlay
them on-air output by manually.



Overview of the User Interface
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A: Preview, B: Playlist panel, C: Control Panel, D: Bottom Panel, E: Info Panel, F: Content
Panel,

G: Timers Panel, H: Audio Bar Panel, I: Top Panel
Preview

You can monitor the item in the playlist which playing.

Playlist Panel

You can import playlist project, export playlist project or create new playlist project. Playlist
project includes all the playlist in Playlist Panel. You can also import an existing playlist by
drag&drop into Playlist Panel. While holding down the Ctrl key after selecting playlists in
Playlist Panel, you can duplicate playlists by dragging and dropping the playlists into the
Playlist Panel.

Control Panel

You can use play, pause, stop, play next, jump, que, que pause and clear cg buttons.

Bottom Panel

You can see the version of Easy OnAir, configure output of Easy OnAir such as resolution,
framerate. After assigning Cg preset, you can play Cg graphics with Logo button. You can lock
or unlock Easy OnAir interface.



Overview of the User Interface

Info Panel

Progress bar on Play tab gives information about clip remain time and clip elapsed time. You
can also move clip elapsed time if Pause button is pressed.

You can assign a live input into a live input window and preview it on Live Inputs tab.

System tab gives information about system performance such as cpu, memory usage. You can
also see video and audio frame cache information, que count and duration.

If a clip is selected in the playlist, File Info tab gives media information such as video format,
duration, video resolution, video framerate, audio channel(s).

You can find a clip in the playlist(s) by searching on Search tab.

Content Panel

You can insert items in playlist such as clips, live inputs, stop, wait, cg show and cg clear events
and more.

Clips can be split, trimmed with mark in and mark out timecode points and checked about
corruption.

There has also additional information sections, you can get video standard, video resolution,
framerate, clip duration, audio channel count and audio sampling rate information. There has
timecodes information which Start, End, Time to Start for each item in playlist.

Timers Panel

You can monitor time information on this panel. Clip Elapsed, Clip Remain, List Remain, Block
Remain and Block Elapsed sections are based as default on interface. Time information are
related with clip and playlist which is playing.

Audio Bar Panel

Audio Bar Panel can be customized with audio channel count, row count and size. Audio level
lines are shown right side of this panel.

Top Panel
Main menu is shown at the top of the window. It contains commands as shown below.

e System > Exit

e Schedule

e View > Preview, Audio Meter, Clock, Clip Total, Clip Elapsed, Clip Remain ...
e Settings > Program setup, Video Setup, Logs Setup, Password, Output ...

e Help > License, Shortcuts, System Info, About



Startup Configuration
Easy OnAir has 3 different type outputs which are SDI, NDI, VGA.

If SDI output will use, server has to be video editing card such as Black Magic Decklink,
Bluefish... When Easy OnAir is opened, output configuration is needed to completed. Click
Output in the submenu of View on top menu bar as shown on Graphics 1.

System FSCHEGHEN View Setbncs |
Progem g
1 dec vetip
At it
O oec setp

Log etag

Graphics 1

Output window will change depend on output types. SDI and VGA output window are same
and shown on Graphics 2, NDI output window is shown on Graphics 3.

Graphics 2 Graphics 3



Startup Configuration

If Easy OnAir output is SDI, you need to select video editing card and its standard. If Easy
OnAir output is VGA or NDI, you just need to select standard for output as shown on Graphics
4. In case of Easy OnAir SDI output, any available is default in Board option which makes the
first available video editing card is chosen on output window. If the system has more than one
video editing card, or the video editing card has more than one output, another output may be
chosen through this option.

ﬂ Choose board -
Board Any available e
Standard | HD1080i50 |
+ HD1080i50
Timecode C
5D ¥
HD Interlaced ¥
501 Out HD Progressive » HD720 p2393
HD720 p2d
-m DCl 2K -] D720 FES
- UHD > P
HD720 p2997
pelak ’ HD720 p30
HD720 p50
HD720 p5994
HD720 p&l
HD1080 p2398
HD1080 p24
HD1080 p25
HD1080 p2997
HD1080 p30
HD1080 p50
HD1080 p5994
HD1080 p&0
Graphics 4

— | Easy OnAir VGA output is especially for virtual output. You also need to install
_:I DtekLive module.




Easy OnAir Control

P (Play) : Plays a chosen or cued video file.
Il (Pause) : Pauses on air video file.

@ (Stop) : Stops on air video file.

®» (Next) : Jumps to next file.

? (Jump) : Jumps to chosen file.

M (Cue) : Cues chosen file.

> (Stop Cue) :Stops on air and Cues chosen file.

Clear CG : Clear all CG Graphics.

Graphics 5



Using Easy OnAir
Using Playlist
Playlist is the list contains video clips, live inputs, cg graphics and events such as wait, stop...
Creating a Playlist
You can create new playlist in 3 ways as follow below.

You can click menu of £3 icon on Content Panel and select New in menu list as shown on
Graphics 6.

M arne:

0 |0Ttems

Graphics 6

You can right-click menu of playlist field on Playlist Panel and select Insert new to create new
blank playlist as shown on Graphics 7.

00:00:00 Insert INS
Insert new

Rename

Remove DEL

Playlist
Field

CG Title Event >
Lego »
Loop ON

View »

Graphics 7



Using Easy OnAir

This step can also be done by clicking on the total playlist count under the playlist field as
shown on Graphics 8 and it will appear as a blank playlist.

i Cont™ Loop
Op G Lenath

Insert INS

Insert new

View »

Graphics 8

Adding Video File on Playlist

You can add video files into playlist via the pop-up window, as shown on Graphics 9, that
shows up by clicking Insert on right-click menu of content field or pressing Insert. You can also
add video files by drag&drop directly from file explorer of OS to content field. Supported file
formats: *.avi; *.mpg; *.mpeg; *.m2p; *.m2v; *.m2ts; *.mp4; *.m4v; *.ts; *.mov; *.flv; *.f4v;
*wmv; *.mkv; *.mxf; *.swf

x|

= I Hanual

] T
| Clips [".avi;".mpg;”. mpeg;”.m2... || Open || Cancel

Graphics 9

Cued video files on playlist are played by clicking Play this on right-click menu of video file,
or B> Dbutton on the control menu; or by pressing Space.

Video files on playlist are removed by clicking Remove on right-click menu of video file in
content field, or by pressing Delete.

=] A video file that is cued or playing cannot be removed.




Using Easy OnAir

Save / Open a Playlist

You can save a playlist by clicking Save As on left-click menu of icon £3 which ~ marked
with red color and shown on Graphics 10.

Graphics 10

Open is chosen on the same menu to open a saved playlist and a window shows up as shown
on Graphics 11. The file path of playlist is chosen and Open is clicked after choosing the
playlist.

| Plaglsts [*.eoal, " ply) Il | Open || Cancel

Graphics 11

Insert from list(s) where is right-click menu of content field, is chosen to insert content from
saved playlist(s) to the playlist which selected as shown on Graphics 12. The contents of
chosen playlist are inserted where the cursor is on the playlist.

Insert INS
Insert from list{s)

Insert live Ctrl+Alt+Y
Insert event >
Insert note Ctrl+Alt+N
Play this Alt+Space

CG Title Event >
Inside Events

Subtitles >
CCaptions >
Lego >
Loop ON

Trirn InfOut. Alt+Enter
Clip Check

Note

Copy Ctrl+C
Remove DEL

View bl

Graphics 12



Using Easy OnAir

If contents of a playlist are updated and has unsaved changes, an asterisk sign (*) appears on
the beginning of its name on playlist field as shown on Graphics 13.

Cont™ Loop

Op Ch

00:59:42

00:39:48

020743 | 4Items

Graphics 13

You can insert playlist file into playlist by drag&drop. Note events will automatically will be
added at begin and end of inserted playlist as shown on Graphics 14. Note events consists of
playlist name and indicates its position.

0|1 i)

13 1
R
0|13 1 V

End Sample Playlist

Graphics 14
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Using Easy OnAir

Save / Open a Program

The program is the project file which consists of all playlists and video files in playlist and
content fields. Save As on left-click menu of 7 icon at Playlist Panel as shown on Graphics
15, is chosen to save a program. An updated program is saved by choosing Save in the same
menu. Open, in the same menu, is chosen to open a saved program. New, in the same menu, is
chosen to create new program.

Cont™ Loop

Graphics 15

r, | Mame

Frogram 001.e0ap

| Frogram [*.eoap, *.dprg) | I Open Cancel

Graphics 16
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Using Easy OnAir

Continuity and Loop on Playlist

Cont and Loop buttons where are on upper side of playlist and content fields as shown on
Graphics 17, allow playlists or contents to jump next, or to go into a loop.

If Cont button of content field is active, it plays all video files in playlist, unless it hasn’t been
interfered. If it’s inactive, one video file plays and it stops. If Loop button of content field is
active, one playlist goes into a loop.

Loop ON button on right click menu of content field on desired video file, is activated to
create loop for only that file.

If Cont button of playlist field is active, until the list of playlists is come to the end, it acts as a
whole and plays all playlists, unless it hasn’t been interfered. There may be partial continuity
by deactivating this Cont button and activating Cont to next buttons on right-click menu of
each playlist. If Loop button of playlist field is active, it jumps from last video of last playlist
on playlist field to first video of first playlist and loop is created.

Clip elapse

00:00:00 " Wait: Last frame

<<NEW ENTRY>>

00:00:00 =

Graphics 17
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Using Easy OnAir

Playlist Events
It’s the list where is in submenu of Insert Event on right-click menu of content field at Content
Panel.
End
Insert from list(s)
Insert live Ctrl+ Alt+V .
Insert event > STOP Ctrl+Alt+5
Insert note Ctrl+Alt+MN Wait Ctrl+Alt+W
Play this Alt+5pace Live (internal passthru)
CG Title Event >|  C6haw
Inside Events Ekileay
Subtitles > P IED
CCaptions > DTMF Command >
GPI Qut Ctrl+Alt+G
Loz ’ TCP Command
Graphics 18
STOP Event

When a STOP event is inserted into a playlist, it acts as the end of playlist and stops playlist.

It may be inserted anywhere on playlist by choosing STOP on submenu of Insert Event on right-
click menu of content field. The inserted STOP event may be drag&drop anywhere on playlist.

M ame

Length

Torle | TrirmCut

Graphics 19

13




Using Easy OnAir

Wait Event
Wait event pauses the playlist as long as the defined time and then jumps to next file.

The settings window, that pops up when Wait is clicked, where is on submenu of Insert Event
on right-click of content field. It is shown on Graphics 20.

§ set Wait event x|

b i 22
Wit I 00 00:00

Graphics 20

Duration of the event, is set by entering the time information as Hour:Minute:Seconds to Wait
box. The output stream during Wait event, is set on Mode box by choosing; Last Frame to hold
last frame of last video file before wait event on the playlist or Black to send output a black
frame.

video 005

End Sample Playlist

01:02:01| 18:41:16| 18:41:37| 00:00:20 |Video 003

Graphics 21
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Using Easy OnAir

Live Event

If the video editing card which Easy OnAir is transmitting to its output, has also an input; Live
event transmits input signal to output.

The settings window, that pops up when Live is clicked, where is on submenu of Insert Event
on right-click of content field, is as shown on Graphics 22. Duration of the event, is set by
entering the time information as Hour:Minute:Seconds to Wait box.

Internal is default selected Blend Mode. Live event is especially a feature for old video editing
cards, output will have key and fill feature to use such as at video mixers with DSK
(Downstream Keyer).

ﬂ Set Live event *
hh:mm:ss
vt
B mode

Graphics 22

CG Show Event

CG Show, where is on submenu of Insert Event on right-click of content field, is one of the
three ways to insert Easy CG layouts into Easy OnAir.

ﬂ%’ Refer to Usage of Character Generator chapter for detailed information and usage
of this event.

CG Clear Event

CG Clear, where is on submenu of Insert Event on right-click of content field, is clear command
of Easy CG layout that has been inserted into Easy OnAir.

I]%a Refer to Usage of Character Generator chapter for detailed information and usage
of this event.

15



Using Easy OnAir

DTMF Tone Event

DTMF Tone event generates Dual-tone multi-frequency signaling (DTMF) cue tone on any
selected audio channel as shown on Graph 23. DTMF Tone key is combination of the row and
column frequencies as shown on Table 1.

1209 Hz | 1336 Hz | 1477 Hz | 1633 Hz
697 Hz 1 2 3 A
770 Hz 4 5 6 B
852 Hz 7 8 9 c
941 Hz * 0 # D
Table 1
[} Set DTMF tone *
DTMFtone |
Audio channels
1 2 3 4
5 6 7 g
9 10 11 12
13 14 15 16
Graphics 23

DTMF Command Event

DTMF Command event is predefined DTMF Tone event as PLAY and STOP to control another
Easy OnAir application. It is on submenu of Insert Event on right-click of content field as shown
on Graph 24.

Insert INS
Insert from list(s)
Insert live Ctrl+Alt+V
Insert event > STOP Ctrl+Alt+5
Insert note Ctrl+Alt+N Wait Cirl+Alt+W
Play this Alt+Space Live (internal passthru)
€6 Title Event » Eotizy
Inside Events ECiay
Subtitles » DiRTglons
CCaptions 5 DTMF Command > PLAY
GPI Qut Ctrl+Alt+G STOP
Loz ’ TCP Command
Loop ON
Trirm In/Qut Alt+Enter
Clip Check
Note
Copy Ctrl+C
Remove DEL
View >
Graphics 24
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Using Easy OnAir

GPI Out Event

GPI Out event is on submenu of Insert Event on right-click of content field as shown on Graph
25. GPI Out event can be sent via RS-232 com port. GPI Out pairs are located at output pins
DTR&RTS. Gpi 1 generates a pulse on DTR, and Gpi 2 generates a pulse on RTS. Gpi 1(DTR)
and/or Gpi 2(RTS) can be set Nothing, Set, Clear. If Gpi 1 and/or Gpi 2 is set Nothing, it won’t
generate pulse. Set option is for high frequency pulse and Clear option is for low frequency
pulse.

Mothing

Set

Clear

Graphics 25

TCP Command Event

TCP Command Event is on submenu of Insert Event on right-click of content field. Third party
application or hardware can be triggered to control over tcp/ip commands.

Graphics 26
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Using Easy OnAir

Insert Note to Playlist

Insert Note, on right-click menu of content field, is chosen to add notes into playlist. The popup
window, that shows up when Insert Note is chosen, is as shown on Graphics 27. After typing
a text into the area, OK is chosen.

[] set Note X

Graphics 27

The note, that has been added between the video files on playlist, doesn’t affect video flow.
Inserted note may be drag&drop anywhere on playlist. Inserted note may be edited by double-
clicking on it on playlist.

Start End Length BlzStart | BlzEnd | Category Hame

. | | | | [|mertfotSampe |

00:02:40 9 Ttems

Graphics 28
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Using Easy OnAir

Inside Events

Inside Event, on right-click menu of content field, is chosen to add notes into playlist. The
popup window, that shows up when Inside Event is chosen, is as shown on Graphics 29. CG,
GPI and DTMF Cue Tone are the events which can add.

[} SetInside Events X

Graphics 29

There are three buttons at right side of preview monitor in the window. Add button adds a new
event. Chg lets you update the event on the list. Del deletes the event on the list.

MNal

i ™
Aad

Length | Ewvert

Your Channel Loge

Graphics 30

There are four columns on the list at right side of preview monitor as shown on Graphics 30.
Start is time information at the beginning of event on the list, represents when the CG is going
to be displayed in timeline of the video file. Length represents the event duration.

To set start time and duration, there has options which are In point (From start), In point (From
end), Out point, Duration. These timecodes can be edited when an event selected on the list. In
point and Out point can also be applied on timeline bar.

ﬂ%b Refer to GPI Out Event for detailed information about GPI.

ﬂg Refer to DTMF Tone Event for detailed information about DTMF Cue Tone.

19



Using Easy OnAir

Trim In-Out a Video File

Trim In/Out button on right-click menu of any video file on playlist, is pressed. Popup window
that shows up, is as shown on Graphics 31. Trim In and Out points can be selected by setting
desired timecode in In and Out timecode field or marking on timecode bar.

[} Easy Trimmer = o X

Total Duration

n [ | Dustion [ | ot | Postion
00:00:13.21 00:02:30.00 00:02:43.20 00:01:25.10

m |lNISpMIOUTI I-mlnl-sec[-frl#rlasecl*mml
oo |

Graphics 31

Split is to create segments of video file. After splitting video file, segments of video file will
appear as a list in Segments bar. Each segment’s trim in and trim out points can also be updated.
You can also check start and end timecode points of each segments by hold Ctrl and pressing
Left or Right key on keyboard. Video clip could be preview frame by frame with Left or Right
key on keyboard.

If video clip contains multi-channel audio track or multiple audio tracks. Each audio stereo

tracks or each audio mono channels can be controlled by click Monitor audio stream as shown
on Graphics 32.

Channel 1

Channel 2

Channel 3

Channel 4

Channel 3

Channel &

futo | 12 Channel 7
~  Listen sterec pair 1: 1+2 Channel 8
Listen stereo pair & 3+4 Channel 9
Listen stereo pair 3: 5+6 Channel 10
Listen stereo pair & T+8 Channel 11
Listen steree pair & 9+10 Channel 12
Listen stereo pair 6 11+12 Channel 13
Listen stereo pair 7t 13+14 Channel 14
Listen stereo pair & 15+16 Channel 13
Maona bl Channel 16

Graphics 32
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Using Easy OnAir

Live Inputs

Easy OnAir have SDI, IP, NDI inputs for Live events. Easy OnAir provides automatic
Up/Down conversion, aspect ratio adjustment and framerate adaption for live inputs. Easy

OnAir support live inputs up to 16.

To select a live input, click Live inputs 1 or Live inputs 2 tab on Info Panel.

DL Mini Recorder | DTMF None DTMF None
HD1080i50 | Control | Control |

Graphics 33

Live input window is shown as Graphics 34. To select a live input, click source selection
button and live inputs will show up as a list. Format is automatically set if live input type is
NDI or IP on Format Selection area. When live input type is SDI, Format will show up as a

list to select one of them.

Preview

Source
Selection

Format DTMF
Selection  Cue Tone
Settings
Graphics 34

n@’ Refer to DTMF Tone Event for detailed information about DTMF Cue Tone
Settings.

=| If ip live input will use up, please install Easy Stream Input and DTekL.ive.
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Using Easy OnAir

Scheduled Playlist

Scheduled Playlist is the second control unit in the same interface. Although it has the same
functionality with main control unit, it has some additional features to play a playlist in a defined
time. Its interface is as shown on Graphics 35.

[ scheduler x

Cont  Loop - ==MNEW ENTRY >>
Op CG Start

Scheduler is active

Clip remain

00:00:20

Graphics 35

Schedule, on top menu bar, is chosen to open scheduled playlist window. Two additional
features, are on right-click menu of each playlist on playlist field, are as shown on Graphics
36.

Insert INS
Mew

Rename
Remaove DEL

Schedule

Schedule in 5 sec

CG Title Event »
Logo »
Loop ON

View »
Graphics 36

— Schedule in 5 Sec: The playlist, that this option is activated from its right-click menu,
starts to play in 5 seconds; and the video file, which had been playing on main playlist,
pauses. The main playlist starts to play from the paused time of the video file, after the
scheduled playlist is over, if it hasn’t been interfered.
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— Schedule: Date and time settings window, is as shown on Graphics 37, is opened for
the playlist that this option is chosen on its right-click menu. The playlist starts to play
on date and time that is set from here, if the Active option is chosen.

B Continuity and loop settings of the scheduled playlist defines the behavior of the
scheduled playlist.

[} schedule X
R vei [ ™|

Stop on Cue tone

Graphics 37
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Using of Character Generator

Cg graphics can be created via Easy Cg and can be used in different ways on Easy OnAir.

Adding CG Graphics into Playlist as a File

Easy CG layout, which has *.vly or *.vmy file extensions, may be added to playlist by
choosing CG Show in submenu of Insert Event on right-click menu of content field.

After choosing the layout on the window that is shown on Graphics 38; Target Plane is set to
GRFX 1 by default, as shown on Graphics 39. One of nine graphics channels of Easy CG may
be set here. The event has been played like a video file when its turn comes in playlist flow.

[ open x

i, ff Mame

WEE Layouks [¥ vy, ® vry]

Graphics 38

[] 5et €6 event *

C:AYour Channel Loga. vy

Cancel

GRFX 2
GRFX 3
GRFX 4
GRFX 5

LOGO O
LOGO 1
LOGO 2

Graphics 39

Clear command for CG may be added, via the window that is shown on Graphics 40, by
choosing CG Clear on submenu of Insert Event and set the graphics channel that is wanted to
be clear. It performs the command when its turn comes in playlist flow.
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u Set CG event *

Target plane GRF<1

GRFX 0
¥ crex
GRFX 2
GRFX 3
GRFX 4
GRFX 5

LOGO O
LOGO 1
LOGO 2

Graphics 40

Cg items in playlist looks like as shown on Graphics 41.

Op CG TTS Shart End Lenath | Mame Trirnlr | TrimCut Audia info

00:00:40 | 15:43:23 | 15:43:23 C( F¥ 1]: Your Channel Logo

00:01:40 | 15:44:24 | 15:44:24 CG [GRFX 1]: Clear

Graphics 41

I]%D Refer to Easy CG User Manual for detailed information of graphics channels of Easy CG.
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Adding CG Graphics into a Video File

The process of adding one or more Easy CG layouts into a video file in one or more time
intervals, may be done in the window that is shown on Graphics 42, by choosing Inside
events in right-click menu of the video file in playlist.

Graphics 42

To add a new CG layout, click Add and choose CG on the list which show up. Choosing layout
window will pop up as shown on Graphics 38. After selection CG layout and one of nine
graphics channels of Easy CG as shown on Graphics 39, CG item will show up in the list of
Inside Event window as shown on Graphics 41.

=| If the settings are configured for the video file, that is on air; the settings will be
active next time when the video file is played.
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CG Title Event
Cqg title event can be applied on a playlist or a playlist item on a playlist.

To prepare a CG Title Event on a playlist item, select a playlist item on a playlist and choose
Setup on submenu of CG Title Event on right-click menu as shown on Graphics 43.

Graphics 43

CG Title Event window will pop up as shown on Graphics 44. Get a CG layout by click
Browse and choose target plane. Start after is start time to display CG Layout and Duration is
the length to show CG layout on playlist item. After setting Start after and Duration times,

click OK.

[] CG Title Event X
Ci5 file:
Target e
Start after 08
Duration 08
Graphics 44

To activate CG Title Event on selected playlist item, choose ON on submenu of CG Title
Event on right-click menu as shown on Graphics 43. After activating CG Title Event on
selected playlist item, CGT icon will appear on CG column of Content Panel as shown on
Graphics 45. CG Title Event is unique for each playlist item. Same steps need to apply for
each playlist item to prepare and activate CG Title Event.

00:00:00| 18:10:18 [ 18:13:41 Video 003

Graphics 45
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Using Easy OnAir

To prepare a CG Title Event on a playlist, select a playlist on Playlist Panel and choose Setup
on submenu of CG Title Event on right-click menu as shown on Graphics 46. To prepare and
activate a CG Title Event, follow same steps for a playlist item except Filename parser file. To
select a filename parser file, click Browse which in related area.

Insert

Insert new

Rename

Remove DEL

CG Title Event > Setup

Loge ¥ ON
+ OFF

Loop ON

View

Graphics 46

@ Refer to Filename Parser in Settings Chapter for detailed information about
preparing a filename parser file.

Using CG Presets

CG Presets is using especially for logo layouts. To assign logo layout to CG Presets, open
preset logo setup window from one of Preset lists in the submenu of Logo Setup on top menu
bar as shown on Graphics 47.

Program setup

Wideo wetup

Audeo setup

_lps sudeo setup

Logs setup

Hetwork

P

DTMF commands

Files checiong

Password

Colors setup

Filename Parser

Logo setup > [Preset 1]

Output [Preset 2]

Output sudsc delay [Preset 3]

Advanced [Preset 4]
[Preset 5]
[Preset 6]
[Preset 7]
[Preset 8]
[Preset 9]
[Preset 10]

Graphics 47

Preset logo setup window can also be opened by click Preset on Bottom Panel as shown on
Graphics 48.
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v [Preset 1]
[Preset 2]
[Preset 3]
[Preset 4]
[Preset 5]
[Preset 6]
[Preset 7]
[Preset 8]
[Preset 9]
[Preset 10]

Graphics 48

Preset logo setup window is shown on Graphics 49. To complete assigning logo layout to CG
Preset, insert logo layout file by click Browse, choose Target plane and click OK. CG Preset
name also can be specified by filling this area. If CG Preset name is changed, its name will
show up in CG Preset list.

[] Preset lego setup X

Graphics 49

Control via Easy CG

Easy CG works integrated with the Easy OnAir. Easy CG may send CG layouts directly to
Easy OnAir, if they are on the same computer.

If both of them are running on the same computer, Easy CG detects Easy OnAir as a server. It
is controlled via Easy CG interface, after selection of server from Easy CG is done.

ISy

Refer to Server Connection chapter on Easy CG User Manual for detailed
information.
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Clip Check

Clip Check is a feature to control video clips for playing properly on Easy OnAir. Clip Check
is checking them by decoding and gives score over 5 with information. Advised score is at
least 3 to play them properly on Easy OnAir.

To use Clip Check, select a video clip in playlist and right-click menu of content field and
choose Clip Check from the list. Clip Check will start to decode selected video item and will
give the results and its score as shown Graphics 50.

[] clip Check x

Graphics 50

Subtitles

Subtitles can be burned into video clip by right-click menu of content field and choose Assign
Subtitle in submenu of Subtitles from the list. Easy OnAir supports SubRip “*.srt” file format.

Subtitle formating features can be changed such as color, font type, font size, style. To apply
style on subtitle, right-click menu of content field and choose Subtitle Setup in submenu of
Subtitles from the list. Subtitle Setup window is shown on Graphics 51.

CG style can also be applied, insert cg layout and mark CG Style option. If CG layout has text
object to style subtitle text, text object must have “Subtitle” tag. The other CG objects in layout
such as box or image for background, no need to add “Subtitle” tag.

[] Subtitle setup x

Graphics 51
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Closed Captions
Easy OnAir supports closed captioning based on EIA-708 standard.

Closed Captions can be assigned by right-click menu of content field and choose Assign
CCaptions in submenu of Captions from the list.

In order to send closed caption signals through SDI, click Output from Settings on top menu
bar and activate 10 bit and CC options as shown and marked with red color on Graph 52.

[] Choose board ¥

HD 1080 i50

Graphics 52

Audio Selection

If video clip contains multiple audio tracks, Audio options will be visible to select in list via
right-click on content field as shown on Graphics 53.

Insert

Insert from list(s)

Insert live Chrl+Alt+V
Insert event

Insert note Ctrl+Alt+N

MULTT-CHA

Play this Alt+Space

CG Title Event

Insicle Events

Subtitles >

CCaptions >

Audio 3 Auto
>

v 48000x6 ita
48000x6 und

Logo
Loop ON

Trim In/Out Alt+Enter
Clip Check

MNote

ALL

Copy Ctrl+C
Remove DEL

View >

Graphics 53
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Using Easy OnAir
A channel is one mono audio feed. A track is an audio container which contains any number
of audio channels.

For example, stereo track contains two audio channels which are left mono audio feed and
right mono audio feed.

Multiple audio tracks are multiple audio tracks with different channel counts configurations.
For example, multiple audio languages with transport streams is common sample for it.

Multi-channel audio track is one audio track contains multiple audio channels. For example,
5.1 audio track is a sample for it.

5.1 audio track contains six audio channels which are front left mono feed (FL), front center
(FC), front right (FR), low frequency (LFE), back left (BL), back right (BR) mono audio feed.

Adding Note on Playlist Item

Note, on right-click menu of content field, is chosen to add notes into playlist. The popup
window, that shows up when Note is chosen, is as shown on Graphics 54. After typing a text
into the area, OK is chosen. Note is shown on Note column at playlist.

[1 Set Note *

Graphics 54
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Interface
Interface Configuration

Interface of Easy OnAir can be customized such as Preview monitor, Audio level monitor,
Time monitor.

Preview Monitor

Appearance of preview monitor may be changed from submenu of Preview in top menu bar
item View. The options on Preview as shown on Graphics 55, are;

— Normal preview

— Big preview
— Popup
— No preview
System "Scheddle™ View Set
Preview > Normal preview
Asdec Mete v Big preview
. Popup
¢ tots No preview
§ ag e
§ e
elag e
- e
» ™
" A i»
-
-lw P ot
. L0g
Graphics 55

Normal preview is default. Big preview extends preview monitor. Popup displays preview
monitor on an external window. No preview inactivates preview monitor.
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Audio Level Monitor

Audio Bar is on Audio Panel as shown on Graphics 56, represents audio level of the playlist

item which is on air simultaneously. Excessive audio peaks like distortions are shown with
different color.

Graphics 56

You can increase audio channel count on Audio Bar by right-click on Audio Bar and select
audio channel count from Channels in the list shows up as shown on Graphics 57.

Graphics 57

Audio Bar lines will change after selection audio channel count as shown on Graphics 58.

Graphics 58
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Time Monitor

Clip Remain is the main timecode which has blue font at Timers Panel as shown on Graphics
59, represents remaining time of video file. You can change Clip remain to other timers such
as List Remain, Block Remain, Clip Elapsed, Block Elapsed ... To do that, right-click on main
timecode and choose timer from the list shows up.

Clip

Video 003

Playlist 001 Playlist

Clip remain Atoal Time

10:38:56

Graphics 59
Clip Elapsed and Block Remain are located as default on Timers Panel.

If you choose Big Preview from View > Preview as shown on Graphics 60, there will show up
2 extra timers on Timers Panel as shown on Graphics 61.

System "Schedule” View Settings

Preview > Marmal preview
Audio Meter > |« Big preview
Clock Popup

Clip total No preview
Clip elapsed

Clip remain

List total

List elapsed

List rernain

Program Total
Time left to Start
Time left to End
Selection duration

Time to Stop

Graphics 60

You can also change each timer by right-click on timecode and choose timer from list shows
up.
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Clip elapsed

00:00:01

Elock remain

01:41:00

Clip remain

00:03:29

Graphics 61

Actual time toolbar shows system clock. Clip toolbar shows the name of playlist item which is
on air. Playlist toolbar shows the name of playlist which is on air.

=] The preview monitor chooses Normal Preview as default size. If it is changed, the
location of the timers may be changed.
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Time Monitoring on Pop-up Window

The options, that can be monitored on pop-up window are in the submenu of View on top menu
bar as shown on Graphics 62;

= Clock = List Remain

= Clip Total » Program Total

= Clip Elapsed = Time left to Start
= Clip Remain = Time left to End

= List Total = Selection Duration
= List Elapsed = Time to Stop

View  Settings

Clock

Clip total

Clip elapsed

Clip remain

List total

List elapsed

List remain
Program Total
Time left to Start
Time left to End
Selection duration

Time to Stop

Graphics 62

Clock is activated to display system clock. Clip Total is activated to display item duration of
selected playlist. Clip Elapsed is activated to display the elapsed time of selected playlist item.
Clip Remain is activated to display the remaining time of selected playlist item. List Total is
activated to display the duration of playlist which is on air. List Elapsed is activated to display
the elapsed time of playlist which is on air. List Remain is activated to display the remaining
time of playlist which is on air. Program Total is activated to display the duration of program
containing all playlists. Time left to Start is activated to display the remaining time of selected
playlist item below of the playlist item which is on air. Time left to End is activated to display
the remaining time of selected playlist which is on air. Selection Duration is activated to display
the duration of selected playlist items. Time to Stop is activated to display the remaining time
of selected STOP event in a playlist in case of Easy OnAir is on air.
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Playlist Columns

Playlist Columns can customizable by right-click on playlist header which blue marked area
as shown on Graphics 63.

Op CG o End

Op

CG

TTS
Start
End
Length
Rls.5tart
Rls.End

00:01:40 ) 11:08:27 00:02:40 |8 Ttems
Category

~  Mame
~  Trimnln
~  TrimCut
Part
Video standard
~  Video info
»  Audio info
Path
Mote

Reset columns

Graphics 63

Play Tab Bar

Timeline bar indicates time progress of playlist item while playing. Locate button helps to
find playlist item which playing in playlists.

Graphics 64
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System Tab Bar

System Tab Bar shows Queue count, Queue duration, Video frame cache, audio frame cache
and system resources usage information such as memory, cpu as shown on Graphics 65.

To get and save image of Easy OnAir output, click Capture output Image.

Capture output
Image

Graphics 65

ﬂg Refer to Advanced in Settings Chapter for detailed information about Queue,
audio and video frame cache.

File Info Tab Bar

File Info Tab Bar shows technical information about video and audio when a video clip is
selected in playlist.

Graphics 66

Search Tab Bar

Search Tab Bar helps to find playlists or playlist item in playlist. Type Search for text box and
click Prev or Next button to find playlist or playlist item.

Graphics 67
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Lock/Unlock Interface

Lock/Unlock button is located at Bottom Panel as shown on Graphics 68. Interface is
unlocked as default.

Graphics 68

To lock interface, click UNLOCKED and it will show up LOCKED as shown on Graphics
69.

Wednesday, 09.May. 2013, 10:44:43

Graphics 69

When interface is locked, Easy OnAir Controls will be locked to control and playlists won’t
be changed or deleted.

A password can assign to use lock and/or unlock interface. To assign a password for lock
and/or unlock, click Password on top menu bar and set a password.
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Settings

Settings submenu can open by click Settings on top menu bar. The submenu of Settings list is
shown on Graphics 70.

Program setup
Video setup

Audio setup

Clips audic setup
Logs setup
Metwork

GP|

DTMF commands
Files checking
Password

Colors setup
Filename Parser
Logo setup >
Output

Output audio delay
Advanced

Graphics 70
Program Setup

Program setup can open on submenu of Settings on top menu bar. Program setup window is
shown as Graphics 71.

[} Program setup >

Graphics 71

When Channel name is typed, it will show up on Easy OnAir header window as shown on
Graphics 72. Warnings is used to give information in case of Easy OnAir won’t open
properly at start up.

Graphics 72
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Video Setup

Video setup can open on submenu of Settings on top menu bar. Video setup window is shown
as Graphics 73.

[] video setup *

Clip sources have output aspect

Graphics 73

You can find following features on video setup:

Aspect ratio:

After enable this features, clips sources will have output aspect. Aspect ratio
feature is useful in case of up/down conversions like SD to HD. For example, output is
HD and some of clips in playlist are SD, clip’s aspect ratio will be 16:9 when it is 4:3.

Fields processing:
Fields processing features eliminate field issues while using the files which is
DV format such as DV, DVCAM, DVCPro, DVCPro50.

SD to HD interlaced processing:
It is a feature to fix deinterlace issues while up conversion process occurred.

Scale video:
To scale Easy OnAir output, enable Horz and/or Vert and their text area will
appear as shown on Graphics 74.

Graphics 74
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— Video quality:
To change video quality of Easy OnAir output, select one of video quality
options which are Low, Normal, Better and Good as shown on Graphics 75.

Graphics 75

— Show board info at output
It is a feature to show video edit card name and its output format on output.

Audio Setup
To open Audio Setup window, click Audio Setup on submenu of Settings on top menu bar.
Easy OnAir has Audio Channel mapping and Dynamic audio limiter compressor features.

Clips in playlist may have different audio levels, and this may result to loudness or silence on
audio output. Dynamic audio limiter compressor prevents this kind of issues at audio output.

X p 1]
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o p |
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E 2]

E |

143 ]

E e

Z e}

| ox |

Dynamic Audio Audio Channel

Limiter Compressor Mapping
Graphics 76

Easy OnAir supports 16 audio channels, and users may need to route audio channels inside
Easy OnAir, Audio Channel Mapping helps to route them inside it.
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Clips Audio Setup

To open Clips Audio Setup window, click Clips Audio Setup on submenu of Settings on top
menu bar.

When a clip is used which has multiple audio channels, Downmix to stereo feature create a
stereo mix by combining all audio channels into a single stereo output.

To order multiple audio/language tracks, use language title metadata which is 3-letter code I1SO
639-2. While ordering audio languages with their language titles, insert comma as separator.

H Setup clips audio >

Downmix to sterea

Graphics 77

- l If clip has multiple audio tracks and to create stereo for each tracks, enable
Downmix to stereo and choose all audio tracks of the clip.

ﬂg Refer to Audio Selection in Using Easy OnAir Chapter for detailed information
about choosing all audio tracks of the clip.
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Logs Setup
To open Logs Setup window, click Logs Setup on submenu of Settings on top menu bar.
Easy OnAir has 3 different logs which are system logs, user logs and default logs.

Default logs extension is *.log. It includes playlist items played time, their file name and on air
duration within single line.

User logs extension with part of its short name is *.usr.log. It includes user interface actions
such as jump, play, stop, changing playlist items position in a playlist.

System logs extension with part of its short name is *.sys.log. It includes logs such as open and
close time of Easy OnAir, changes about output configuration.

Log files location is the Logs folder in Easy OnAir default installation folder.

Network

To open Network window, click Network on submenu of Settings on top menu bar. Easy OnAir
can be controlled with Easy Net Controller by tcp/ip communication. The communication
protocol is Media Object Server Communications protocol (MOS). To use Easy OnAir as a
server on a client, type a number and activate Enable server as shown on Graphics 78.

ﬂ Setup network -

Port:| 5000

Graphics 78

To increase playout operation safety, use mirror playout automation. Mirror mode is fully
redundant which using master and slaves of Easy OnAir. Easy Net Controller is a client
application to create a mirror playout automation or M+N backup facility.
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GPI

To open GPI setup window, click GP1 on submenu of Settings on top menu bar and it will show
up as shown on Graphics 79. Easy OnAir can also be control over General Purpose Interface
(GPI). Choose a com port and customize actions based on GPI signals which are DSR, DCD,
RI, CTS.

[ GPIsetup X
Pot  Sgnallh _ DSR 0co RI cTs

[ ] setn] | | | \

Signal Out| |+ Disabled

Py \

Stop

Stop +Go next Clip

Stop +Go next List

Pause

Next

Logo OFF

Logo preset 1

Logo preset 2

Logo preset 3

Logo preset 4

Logo preset 5

Logo preset §

Logo preset 7

Logo preset 3

Logo preset 9

Logo preset 10

Schedule: Play

Schedule: Stop

Sehedule: Stop +Go next Clip
Schedule: Stop =Go next List

Graphics 79

DTMF Commands

To open DTMF Commands window, click DTMF commands on submenu of Settings on top
menu bar and it will show up as shown on Graphics 80.

[ DTMF commands setup x

Name Command Audio channel

PLAY  12345# Al .

STOP 54321 Al ..
1. Al .|
2 Al .|
3 Al ]
4. Al .|
5. Al .|
5. Al .|
7 Al .|
8. Al .|
9 Al .|
10 Al .|

Graphics 80

You can customize DTMF commands by giving a name, choosing audio channel and typing
DTMF tone key.

I]%’ Refer to DTMF Tone Event and DTMF Command Event from Playlist Events in
Using Easy OnAir Chapter for detailed information about DTMF commands and
DTMF tones.
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Files Checking

To open Files Checking window, click Files Checking on submenu of Settings on top menu bar
and it will show up as shown on Graphics 81.

[ Files checking *

Graphics 81

While inserting clips into a playlist, Easy OnAir checks and shows warning as pop up in case
of clips not play properly.

To check clips exists or not in playlists, enable Check if files exists every option and type
interval time in seconds to check. If one of clips in playlist does not exist, the clip line color
will change. Extend checking is a feature to cache the clips in a playlist when Network
Attached Storage (NAS) is used.

To save playlists in interval times, select Autosave program every option and type duration in
seconds for interval times.

Password

To open Password window, click Password on submenu of Settings on top menu bar and it will
show up as shown on Graphics 82.

ﬂ Setup security >

Graphics 82
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Colors Setup

To customize playlist item line and text colors with different indicators, click Colors Setup on
submenu of Settings on top menu bar and it will show up as shown on Graphics 83.

A ooliooooon

Graphics 83

Filename Parser

To open Filename Parser window, click Filename Parser on submenu of Settings on top menu
bar and it will show up as shown on Graphics 84.

Graphics 84

To prepare finename parser, choose CG layers by click Choose file, then click + plus sign and
its options will show up as shown on Graphics 85.

Title

Category

Star

Note

TapelD
UserBits
ReferenceCode
None
SEPARATOR

Graphics 85
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Logo Setup

ﬂg Refer to Using Easy CG Presets from Using of Character Generator in Using Easy
OnAir Chapter for detailed information about Logo Setup.

Output

Please read Quick Configuration Chapter for different output configuration.

Easy OnAir supports sending timecode data through SDI as RP188, LTC and VITC (Fieldl
and/or Field2).

To get detailed information about closed caption data through SDI, read Closed Captions

From Using Easy OnAir Chapter.

Output Audio Delay

To open Output Audio Delay window, click Output Audio Delay on submenu of Settings on
top menu bar and it will show up as shown on Graphics 86.

Output Audio Delay may be used when there has tv channel infrastructure system. Tv channel
infrastructure system may use broadcast devices such as audio mixer, video mixer, video
infrastructure, audio infrastructure. In this case, audio and video signals will have different
outputs and there may have a fixed audio video sync problem. To fix audio video sync
problem, use audio delay or audio hasten.

[} Setup output audio delay *

Graphics 86
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Advanced

To open Advanced window, click Advanced on submenu of Settings on top menu bar and it
will show up as shown on Graphics 87.

u Advanced settings *

Graphics 87

Advanced Settings options are shown below.

MediaLink:

MediaLink is virtual output of Easy OnAir. To use virtual output of Easy OnAir, please
install Easy DtekLive module.

Cache -> Read:
It is cache size per item which cued in playlist. Its size unit is Megabit.

Cache ->Play:

It is cache frame count which item is on air to play. As video and audio cache frame
count increases, video edit card delay will increase. For example, use lower values for
news channels, use higher values for movie channels.

Cue:
It is total cued duration for item or items in playlist. Its time unit is second.
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Sample configuration for cue, read cache, play cache and its results in playlist is shown
on Graphics 88 and Graphics 89 respectively.

& Enagine

jead
b ernany b ax 00 | M ax.
= Flay
Wideo, Frames
Audio. Frames 3| Cache framesz for play [Range 3-100, bigger = more delay)
= Cue

kinCirs 20| Minirurn queusd duration in zeconds [1-30]

Graphics 88

Length MHame

00:00:03 | 14:12:43 | 14:12:48| 00:00:05 |Video 003 V\devteknas\Media\sample\Video 003.mpg
00:00:08| 14:12:48| 14:12:53 00:00:05 |Video 004 \idevteknas\Media\sampletVideo 004.mpg

00:00:13|14:12:53 | 14:12:58| 00:00:05 |Video 005 V\devteknas\Media\sample\Video 005.mpg
00:00:18|14:12:58 | 14:13:03 00:00:05 |Video 006 V\devteknas\Media\sample\Video 006.mpg
00:00:23|14:13:03| 14:13:08| 00:00:05 |Video 007 \\devteknas\Media\sample\Video 007.mpg
00:00:28|14:13:08| 14:13:13| 00:00:05 |Video 008 \idevteknas\Media\sampletVideo 008.mpg
00:00:33|14:13:13 00:00:40 |8 Items

Graphics 89

n Icon represents cued items in playlist. Clip items location in playlist is NAS in this sample
configuration. Even NAS network connection is lost, Easy OnAir will keep to play cued items
in the playlist without any problem.

- TBC:

It is time base corrector and when it is active, time to start timecodes (TTS) of each
items in playlist will be constant.

— CG Blending:
Easy OnAir consumes system CPU, to decrease consuming CPU, select CPU + GPU
option if system has Graphic card.

— Process Priority:
It is operating system process priority. The priority levels range from Normal to Max.

— Decode Threads:

It is thread count for decode processing. Its default value is Auto and the thread count
range is up to 16.
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Restrictions and Activation
Restrictions of Demo Version

Even though demo version of Easy OnAir doesn’t have any restriction on interface, it adds a
watermark to the output as it’s seen on preview monitor. Once the activation process is done,
the watermark will disappear.

Activation

You need to submit a licence file and send it to us, it is shown on Graphics 90, where it can be
seen via License in Help on top menu bar.

If you have licence file, to activate Easy OnAir license, insert licence file into Easy OnAir
installation folder and click Licence in Help on top menu bar.

The watermark is disappeared from preview monitor and output, after this process.

=181

Licence
Shortcuts
About

Actual Time

17:17:37

Cont Loop

Graphics 90
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Technical Support

General support is available from Easy Media Suite web site by using the following
URL.: http://www.easymediasuite.com/ . A client may click on TechSupport on the web site
and open a ticket for a timely response.

Services;

— Phone Support
Easy Media Suite provides 7x24 on-line phone support.

— On-site Support
Easy Media Suite provides on-site support as needed either during a project launch
phase or in the case of the problem cannot be solved over the phone.

— Remote Access
Easy Media Suite provides remote support over Virtual Private Network for its
customers. Upgradations, system configuration and log management may be handled
via VPN.
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Contact
Devtek Bilisim Elektronik San. Tic. Ltd. Sti.

Kaptanpasa Mah. Piyalepasa Bulvar1 Famas Plaza B Blok Kat 15 No 105-108 Okmeydant
Istanbul/ TURKEY

Tel (+90) 212 582 23 07

Fax (+90) 212 582 93 95
E-Mail info@easymediasuite.com
Web www.easymediasuite.com
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